In the Fall 2019 semester, the MC Library partnered with ELITE to bring library course reserves, research guides, tutorials, videos, and quizzes into more than 4000 Blackboard courses. By all accounts, the initiative was a success. One faculty member told the library: “I plan to include it in ALL my future online and in class sections.” Another faculty member said, “I appreciate the library resources available and feel they contribute to my students’ success.”

This new integration is now available in all Spring 2020 Blackboard courses. It includes three tools:

- **Course Reserves** - Help your students save money with library course reserves. The course reserves tool lists course-related materials that the faculty member has requested for their students through the MC Library. Faculty can use the tool to request that course-related items (textbooks, journal articles, book chapters, and more) be placed on reserve in the library. Faculty should encourage their students to use course reserves and help save them the cost of a textbook.

- **Course Pages and Research Guides** - Help your students complete assignments with library course pages and research guides. Library course pages, research guides, and research toolkits are mini-websites built by MC librarians to help students find, evaluate, present, and cite resources for a specific class or on a specific academic subject. Each Blackboard course automatically links to the most relevant guide for that course. These guides are a great way to help students meet assignment outcomes.

- **Information Literacy Content** - Build your students’ skills with information literacy content. This tool enables faculty to easily pull tutorials, videos, and quizzes into their Blackboard course. These items cover information literacy concepts like reading a scholarly paper, searching with keywords, debunking fake news, and citing sources. Faculty can select the most relevant tutorials, videos, or quizzes for their outcomes and embed them directly into their Blackboard course for their students to access.

Faculty and students can access these tools by clicking the “Library” link in the course menu. Faculty who would like assistance with any of these tools should access the support materials online or contact the librarian from your campus who specializes in your subject area.
A New Feature on the Hub

Are you looking for something good to read?

Check out For Your Reading Pleasure, the Hub Recommends.

Every month, the Hub will recommend a stimulating, thought-provoking book which is germane to our work at Montgomery College. See what your colleagues thought about the book and leave comments for others to enjoy.

Ask ELITE

Have you ever asked, “What is ELITE and What Do They Do?”

Now is your time to ask us. The Ask ELITE feature allows MC faculty and staff to email their questions regarding teaching and training to the ELITE team.

A team member will research the question and get back to the employee as quickly as possible with a response and possibly suggestions for next steps, as appropriate.

If you have questions about pedagogy or teaching methodology, or if you are curious about some aspect of staff development, email your questions to AskELITE@montgomerycollege.edu.

Those questions and responses which are likely to have the greatest general interest to the College community will be archived on the Hub for future reference.

ELITE Welcomes Two New Staff Members

ELITE would like to introduce two new staff members to the team. Marcy Jackson has joined ELITE as a Program Manager from WDCE to focus on expanding the online non-credit offerings. Christine Tracey is an Administrative Associate who will focus on organizational development, open education resources, and the virtual campus.

Ms. Jackson is a diverse educator with 25 years of experience educating adults and leading initiatives. She has been at MC for 17 years, beginning as an adjunct faculty for WDCE and CPOD. For the past 15 years, she has been a WDCE program manager/director for multiple programs and institutes delivering contract, grant, and open enrollment courses. Her duties included enrollment management, program and instructional design, and faculty development. She has led webinars and supported faculty in the use of Blackboard. She has contributed her leadership and advocacy skills college-wide, on entrepreneurship, governance, industry partnerships, sustainability, and disability programming.

Ms. Jackson has been recognized at MC with the Above and Beyond Award for grants and external funding, a Visionary Award for the Event Management program, and a Teamwork Award for a database implementation. She graduated from Towson University as a student-athlete with a BA degree in International Relations and a minor in Asian Studies and Management. She was honored as Towson's Outstanding Woman of the Year for her leadership and innovation. Ms. Jackson also earned an MA degree from University of South Dakota in Education Administration with an emphasis on Adult and Higher Education. She holds certifications as a Faculty Developer (CFD), Program Planner (CPP), in Special Needs Advocacy, and as a Facilitative Leadership Trainer.

Ms. Tracey is starting her 12th year at Montgomery College. For more than six years, she served in the newly created position of Faculty Outreach Librarian before becoming the Campus Library Manager at the Rockville campus library for more than three years. During her time as manager, she instituted changes that focused on working conditions, morale, relationships, and the overall culture of the campus library.

With many years of experience working in the private sector, government, and in academic and public library settings, she brings her passion for transformational leadership, courageous visioning, and identifying the strengths and motivations of individuals to maximize employee engagement and help lead teams through change to her current Administrative Associate position in ELITE.

Ms. Tracey is a doctoral candidate at Drexel University's Educational Leadership and Management program with a concentration in Organization Development and Adult Learning. She has a master's degree in Library Science and Information Systems from Drexel and a BA in Political Science from Villanova University in PA.
Blackboard and Co-listed Courses

If you are one of the many faculty who have a credit course that is co-listed with a non-credit course, and you use a Blackboard site to share materials, there are a couple of things you need to know.

Most faculty choose to place course content in the credit CRN. Unfortunately, your non-credit students will not be able to access that content unless additional measures are taken to provide them with that access.

One option is to merge the two sections in Blackboard. But first, you would need to request a Blackboard site for the non-credit CRN. Unlike credit courses, non-credit courses do not automatically receive a Blackboard shell, and without a Blackboard shell, no merge is possible. However, once that merge has been done, students from both sides will be able to access and use your materials. The form to request a supplemental Blackboard shell can be found by going to the ELITE's website and then to Forms.

Another possibility is to have your non-credit students manually added to the credit site in Blackboard. This works well if you have only a few students that usually register in the non-credit section. The downside to this option is that late registrants would not automatically be added. Historically though, that hasn't proven to be much of an issue.

If you have any questions about either of these options, please contact Jeana Beaulieu via email or 240-567-6002.

Blackboard Archive of all Courses Prior to Fall 2018

In an ongoing effort to ensure that Blackboard runs as quickly and as efficiently as possible, an archive of Blackboard courses prior to Fall 2018 will take place on January 29, 2020.

Courses are kept on the production Blackboard system for the current academic year and the previous academic year. After that, courses are saved in the Blackboard archives. Development and test Blackboard sites will not be affected.

If an archived course needs to be restored, the course instructor should submit a request to ELITE, and the course site will be restored. Instructors are also encouraged to create and keep a local archive of their own content, courses, and grade books.

Instructions for creating and restoring those archives can be found in the learning center, or will be provided upon request.

Please be aware that SafeAssign documents cannot be archived. SafeAssign documents are only guaranteed to be retained for the current semester. They may remain as long as the Blackboard course is centrally stored, but they cannot be included in any of the archives of student coursework because the data is stored on a SafeAssign database.

If you have any questions, please contact Robin Cook at 240-567-6003 or via email.
Faculty Spotlight: Shelley Jones, Professor of Spanish

In this edition of the ELITE Newsletter, we are delighted to “spotlight” a faculty member who is helping to educate MC students in Spanish. We hear today from Shelley Jones, Professor of Spanish at the Montgomery College Takoma Park/Silver Spring campus.

Q1. Shelley, when did you arrive at Montgomery College and what brought you here? Are you a native Marylander?

I have spent most of my life in Maryland, graduating from Oxon Hill High School in Prince George's County, and later attending McDaniel College for my undergraduate education (double major in Spanish and Social Work), and then UMD College Park for my Masters degree (Latin American Literature).

I came to Montgomery College as an adjunct professor after many years of teaching middle school and ultimately serving as middle school principal at Barrie School, a Montgomery County independent school in Silver Spring.

The experience of working in academic administration was a valuable one and yet it took me further away from my professional passion: classroom teaching. Coming to Montgomery College in 2005 provided me an opportunity to once again interact with students in a direct and meaningful way. I became a full Professor at MC in 2019.

Q2. We understand that you are a member of the Global Humanities Institute (GHI). What is function of that organization and what do you do in that role? Elaborate please, if you can.

The GHI is an enterprise originally funded by a National Endowment for the Humanities grant which created (and continues to create) initiatives to encourage robust global education at Montgomery College. As a member of the original GHI workgroup formed in 2012, I have been fortunate to help create and participate in many of its programs, for example: a collaborative virtual art exhibit with the University of El Salvador and Xian University in China, two opportunities to travel to El Salvador during which relationships with our international academic partners were established and strengthened, the annual Humanities Days celebration featuring events that highlight the global Humanities on all three MC campuses, and our Global Classrooms program in which MC students and faculty meet and collaborate virtually with international colleagues in the interest of deepening cultural and, in many instances, linguistic understanding. My work with the GHI has been, without a doubt, one of my most rewarding professional experiences to date.

Q3. We also learned that you were a Global Classroom Fellow? Is that correct? What do Global Classroom Fellows do? What are their goals? What challenges do they face? Can you share with us any progress or status of that Fellowship? Is this Fellowship part of the Global Humanities institute?

The Global Classrooms Faculty Fellowship (GCFF) officially began in 2016, though my colleague Carla Naranjo and I have been engaged with virtual classroom exchanges with our colleagues at the University of El Salvador (UES) since before the Fellowship began. My first virtual exchange was a result of connections made with English professors from the UES during a 2013 visit to El Salvador with then-GHI Director Rita Kranidis and ELAP/ENGL professor Marcia Bronstein. The program has developed to include the GCFF of which I am not a Fellow, but rather co-coordinator with my Germantown colleague Prof. Carla Naranjo. The Fellowship spans two semesters during which time faculty from various Humanities and Social Sciences disciplines learn about curriculum development, technology, intercultural communication and other skills necessary to create and execute a virtual international exchange. The second semester of the Fellowship guides participants to bring their GC projects to fruition as part of the outcomes for one of their courses.

Initially the GCFF was a GHI initiative, but has since been adopted and supported by ELITE and the Humanities department at MC.
Q4. From the schedule of classes, we notice that you teach various Spanish courses. How exactly are your Spanish courses delivered? Do you and/or the students use technology as part of the courses? If so, what kinds of technology? Are there any tools that you think you “must have” to teach your courses successfully?

Technology figures very prominently in all World Languages courses. In courses where physical texts are used, students complete practice exercises and view tutorials and test preparation videos online and instructors use online resources during class time. The signature assignment for all World Languages courses, including Spanish, requires that students use technology to research and present on a topic relevant to the course. In the past several semesters, the Spanish department has piloted and adopted several Z-courses and OER courses. I have taught both beginning and intermediate Spanish courses using fully online resources.

Technology figures even more heavily if the course includes a Global Classrooms component. In this case, we use GoToMeeting or Skype to meet with our counterparts abroad in class. In many instances, students continue communicating with individual students from the partner institution outside of class using technology such as WhatsApp, Facebook, Skype or other applications.

Q5. We see that your elementary classes are for non-native Spanish students. So, it seems you get a lot of students who are learning totally from scratch, so to speak. What are some common obstacles these students have to master to be successful?

Yes. The beginning levels are not intended for students who have taken Spanish beyond the first couple of levels in high school. Because even the beginning levels at MC are taught in Spanish, it takes new learners a while to accumulate the vocabulary and hone their language learning skills like interpreting body language, following context clues, etc. It's amazing to see these new learners develop right before my eyes. By the end of the semester, they are presenting (at a novice level, of course) their cultural projects to the class in Spanish and able to hold simple conversations in the target language. I love to hear students excitedly report that they were able to use what they learned in class to speak in Spanish with a friend or co-worker. One of the other obstacles that new and even more experienced learners of Spanish face is approaching the courses with the erroneous assumption that Spanish is easy to master. It takes a significant amount of time and energy engaging with the material to reach even a novice level of competence. I often get asked how long it will take to become proficient in the language. My answer is always the same: It is entirely up to the learner and how much effort s/he/they is/are willing to expend.

Q6. Do you use the Blackboard Learning Management System (LMS) in any way in your classes? If so, do you use any of the tools in Blackboard to deliver your courses?

I use Blackboard in all of my classes as an organizational tool and informational resource for my students. I have on occasion used the “Journals” tool and we offer the “Smart thinking” tutoring option to our students as well.

Q7. Do you think Spanish is a subject that can be learned in an online environment? If not, what do you think prevents online delivery of Spanish, or any other language?

We offer several online or hybrid sections of Spanish at MC, though I’ve never taught any of these sections. Though I plan to take the training to be qualified to teach DL courses, I enjoy and get my professional energy from direct, face-to-face interaction with students so I’ve not opted to teach one of the online sections. I know that these are offered for student convenience and that there are good online tools available to encourage students to learn and produce the language effectively. I also know that students crave and respond well to the kind of support that face-to-face personal interaction can offer. They spend enough time outside of class with the relatively impersonal forms of communication available to them.

Q8. Do you have any other information of interest that the readers may appreciate hearing about you, your professional or personal interests, or the programs and other outreach activities that you are involved in at the College?
I have taken advantage of the ways in which MC encourages its faculty to innovate and continue to grow professionally including through Make It Happen grants, the Global Classrooms program, faculty travel study opportunities, the Paul Peck Smithsonian Fellowship and the Scholarship for Excellence in Teaching (SET) Fellowship. These innovative projects have provided me with plenty of material to present at various professional conferences as well.

I’ve served as advisor to student clubs such as MC Allies ((supporting LGBTQ students, faculty and staff), the Music Club, the Latino Student Union, and the Spanish Conversation Club.

Personally, I am a dedicated outdoorswoman and enjoy hiking, birding, kayaking and most other outdoor activities. I ride my bike to MC most days (nothing heroic—I live about 2.5 miles away) and would love to find more ways to encourage students to cultivate a positive relationship with the natural world.

UN SDGs Open Pedagogy Faculty Fellowship Student Showcase

Faculty, staff and students are invited to the second United Nations Sustainable Development Goals (UN SDGs) Open Pedagogy Faculty Fellowship student showcase.

Through the first-ever international partnership between MC and Kwantlen Polytechnic University (KPU) in British Columbia, Canada, faculty teams worked collaboratively to create renewable interdisciplinary assignments—an example of an Open Educational Resources (OERs). These assignments, deployed in Fall 2019 courses, are centered on various UN SDGs such as reducing poverty, improving well-being, increasing economic growth, and strengthening peace and justice.

This faculty fellowship helps the College achieve Goal #2 in MC 2025: Enhance transformational teaching practices and learning environments. These renewable interdisciplinary assignments engage the students in the learning process to improve their communities, while the faculty get an opportunity to implement community-engaged open pedagogy in their classrooms. In this type of educational practice, students and faculty are partners in developing the content and product, and sharing them with others for public consumption. This high-impact educational partnership is critical for effective and meaningful deep learning.

The student showcase offers a number of selected students an opportunity to present on their work. The student showcase is scheduled for Tuesday, February 25, from 2:30 - 4:30 pm, in the Science West building (SW), Room 301.
Lunar New Year Across Nations

On January 10, ELITE held a multicultural/diversity class, part of the In Their Own Voices series, on “Lunar New Year Across Nations.” The class promoted an understanding of the significance and traditions associated with Lunar New Year celebrations and became a great party.

A table of panelists shared their favorite family and community customs from diverse nations: Bo Chan (Hong Kong, China); Sharmini Azeez and Manuri Perera (Sri Lanka); Thanh King and Nghi Nguyen (Vietnam). Class participants were treated to New Year’s snacks and food sampling. In addition, everyone received a red envelope, a tradition of Lunar New Year, symbolizing good luck for the year to come.

Lunar New Year, an ethnic rather than religious holiday, has many names: Chinese Chunjie, Vietnam Tet, Korean Solnal, and Tibetan Losar. It’s a time for family and neighbors to prepare traditional meals, buy new clothes, and most importantly, spend time together. Over 1.3 billion people worldwide celebrate Lunar New Year. In 2020, the holiday is January 25. In Chinese tradition, it is the year of the Rat.

ELITE wishes a “Happy New Year” to all employees who are celebrating this season!

The “In Their Own Voices” series opens communication, expands empathy, and reduces assumptions. Please check MC Learns to register for the next class in the series: April 17, 9:00 – 11:00 am, in Mannakee 122, on “Celebrating Tattoos and Body Art”!

Quality Matters

Montgomery College is active with QM as there are 137 faculty/staff with MyQM accounts, as well as 109 people who have taken a QM professional development workshop. Montgomery College also has 8 Peer Reviewers, 1 Master Reviewer, 78 courses submitted for review, and Peer Reviewers who have served on 158 course reviews.

QM Training

Applying the Quality Matters Rubric (APPQMR) is a one day course which informs you of the QM Rubric and process.

A three-week online course (about 15 hours), called Peer Reviewer Certification (PRC), is a review of the content of the one day APPQMR training and provides extra information about being a QM Peer Reviewer.

QM Reviews

In addition to training online faculty about quality online course design, Montgomery College, through ELITE, is looking for faculty members who want to have their online courses reviewed in an official QM review.

ELITE provides considerable pre-review support which includes training and an informal pre-review of the course before the official review takes place.

For additional information, please visit the ELITE’s Quality Matters Website.
Women's Symposium in Leadership: The Fight to Vote

Kicking off with a high-powered and inspiring keynote speaker, the 2nd Annual Women's Symposium is centered on women as leaders and voting rights.

Participants will discuss and celebrate the 100th anniversary of women suffrage in the US, while simultaneously critically examining the history of exclusion of women and men of color. The symposium will strive to create a complete picture of the struggles and the triumphs surrounding the right to vote in the US during the last 100 years.

Participants will hear from Dr. Pollard by video message and enjoy a theatrical performance. Through panels with women leaders describing their life stories and elective workshops on topics relevant to women in leadership roles, MC students, staff and faculty will examine what it takes for women to lead and be successful in the US and in global society.

The event will be held on Friday, March 27, from 8:00 am - 4:30 pm at the Takoma Park/Silver Spring campus in the Cultural Arts Center.

To register, please access MC Learns and select Pedagogy & Instruction.

If you have questions, please contact Dr. Carolien Annink.

Employee Professional Development Announcements

There have been some interesting innovations in the Learning Pathway and Cohort classes this year. Of particular noteworthiness has been the involvement of MC employees creating and delivering customized training material, related to their professional roles at the college, in the classes.

For example, three HR staff members deliver material on strategic planning and recruitment, an Employer Relations Director and investigators deliver a whole day training, two specialists from WDCE create a WDCE Awareness half-day workshop, and a dedicated group of MC Spanish-speaking professionals create two language classes focused on MC Customer Service for Spanish Learners.

Further involvement includes employees co-facilitating a cross-cultural courtesy class, assisting with design for a management learning pathway, and serving on discussion panels.

The involvement of MC employees in professional development training adds value to the classes. It also offers MC employees an opportunity to experience a challenging new role. ELITE looks forward to working with more MC employees who can assist ELITE in its mission to bring a high standard of professional development training to the pathway and cohort programs.

Open Educational Resources (OERs) Petting Zoo

Following the examples of colleges around the country who want to promote open educational resources to their faculty ELITE has set up an OER Petting Zoo.

The “Zoo” is a place where faculty can browse and examine various open educational resources. The debut of the zoo was at the Spring Opening meeting at Takoma Park, but it will be moved around during the spring semester. Check Inside MC this semester as the Zoo gets moved around.

Montgomery College, with the help of ELITE, is committed to a program of informing, orienting, and training faculty and staff regarding Open Educational Resources (OERs). An OER is a learning material that, for the most part, is free to use by others and that has usage rights displayed that tell the user how he or she can use the information in their classes.
Staff Spotlight: Kraig Kinsey, Rockville Mail Room

In this edition of the ELITE Newsletter we are delighted to “spotlight” a staff member who was a Pool Manager at Montgomery College and who now works in the Mail Room at Rockville. We hear today from Kraig Kinsey, who was nominated to be our Staff Spotlight person by not just one, but two ELITE staff.

Q1. Kraig, how long have you been at Montgomery College and what are some things you were doing prior to arriving here?

I am at the start of my 33rd year working with Montgomery College. I started working at the TPSS Aquatic Center in 1986 and attended Montgomery College from 1984 through 1987. I then transferred and graduated from University of Maryland University College in 1990 with a B.S. in Management. Additionally, during my MC career I have been a Part Time Faculty member teaching Aquatic Fitness and Beginning Swimming and Aquatic Fitness for the Wellness Program.

Q2. When you were the pool manager at Takoma Park/Silver Spring what were some of the things you did to make the pool operations run successfully? And what were some of the more challenging aspects of that job?

All swimming pools require a daily commitment with highest standards for swimmer safety and local HHS Compliance. Our exemplary safety record and high standard to be open every day as scheduled provided continuous access for the College and our community. Providing a safe and positive learning atmosphere was always the daily standard for our facility.

My biggest challenge was staffing the facility properly to fit its varying schedule and diverse occupancy. We were very fortunate over the years to have hard working diligent staff and student employees who were willing to go the extra mile to accommodate the schedule. While this was the greatest challenge, it was also one of the most fulfilling parts of my job. Hiring new staff and watching experienced staff “make their move” towards goals beyond the Aquatic Center and Montgomery College is vital to our mission success.

Q3. You are now working in the Rockville Mail Room. Tell us a little bit, about how the mail works its way to, though, and from the Rockville mailroom. How does that process work? What about oversized items. Is it “If it Fits, It ships” or are their restrictions on what you handle?

To be concise as I can, all Mail sent except for on your respective Campus is sorted and delivered via the Rockville Mail Room. Rockville processes all Inter-Campus Department Mail and U.S. Mail. Inter Campus Mail is picked up and delivered once per day at each Campus Location. All Inter Campus Mail envelopes require the recipient and senders department and campus location. Building and room numbers are not required at this time. Oversized items are restricted by weight and size. Central Receiving or the vendor normally delivers them.

Q4. You have been identified as someone who strongly embraces the professional development opportunities that come your way at MC. Our observers say you enthusiastic, candid, and willing to share stories about your life’s experiences, all of which enrich the entire group. That is great. What have been your favorite professional development activities at MC? Can you tell us why?

Over the span of a few decades, I have made a conscious effort to attend as many ELITE opportunities to enhance my career skills. However, my greatest motivation to attend ELITE and other professional development opportunities is the
learning atmosphere and experience. When I am learning something new, I am always motivated professionally and personally.

ELITE contracts very experienced instructors who create a safe space to share new ideas, as well as, professional and personal experiences. I always take away applicable practical skills from the instructor and many more from colleagues. The employees attending ELITE typically represent many areas of the College. I see these training opportunities solidifying our One College approach when we understand another employee's role and mission within the College and how it may relate to our own.

Q5. We understand that you took the Customer Service class offered by ELITE. In your opinion, what were some of the more notable takeaways you were able to get from that particular class? Do you employ any of the tools or ideas you learned in that class in your current position in the Mail Room?

The Customer Service class was instantly helpful with my new position. My biggest take away was to be 100 percent present and mindful when providing service. Listening, not reacting, and asking questions all lead to a good customer service experience.

Q6. If you were talking to someone at a party and they asked you what it is like to work at MC what might be some things you would want to mention, and why?

Certainly, the career longevity of so many employees over decades is always a good talking point. I am in my 33rd year and I know many retirees who worked for over 40 years. I would also mention my many positive moments with students I have instructed or supervised. Their passion for their academic goals and work ethic continue to impress me. I am still, and always will be learning from them.

**Cool New Features of Microsoft Office**

Office 365 is a subscription with a wide range of services that cover Office Online, collaboration tools, and cloud storage. Office Online includes your standard productivity applications such as Word, Excel, and PowerPoint. Although these applications look very similar to the ones installed on your desktop, the online version offers capabilities that facilitate your ability to share and collaborate with others more easily through the use of OneDrive.

**What is OneDrive?**

OneDrive is your personal cloud storage. When you save a document to OneDrive, it is available from any location provided that you are connected to the Internet. Just log in to your Office 365 account to retrieve and edit a file. Your work is never lost as it is being saved continuously. When teamwork is required, collaboration occurs by sharing a link to a file from OneDrive. Everyone with the link has access to the same file and collaborators are able to see changes in real-time.

As you increase your use and proficiency with Office 365, you will also increase your productivity. The days of emailing large documents, keeping track of flash drives, or connecting remotely to a VPN are no longer your only solutions to working with files.

In 2016, Montgomery College introduced Office 365 for Business to all faculty and staff. You may have used the Office 365 icon on your desktop to log in, but you can also log in to your account through MyMC or directly through the Office Portal.

Below are other features of Microsoft Office that you can use.

**PowerPoint Designer**

PowerPoint Designer is a sophisticated artificial intelligence feature useful for creating beautiful and professional
Refer Students to the Online Student Pre-Assessment Tool

ELITE developed an instrument for prospective learners to pre-assess their readiness for online learning. The instrument is a short, 12 question survey, based on attributes known to be important for distance learners. We highly encourage faculty who teach online courses to let their prospective students know of this tool. Some faculty put the link directly into their Start Here modules in their Blackboard sites, and some faculty members ask registered students to take this pre-assessment and have results sent to them before classes begin.

Online Syllabus – Sample Template

ELITE developed a sample online syllabus, with examples, for online faculty to see and perhaps borrow from. The syllabus is based on the revised standard syllabus template, tentatively approved by MC Faculty Issues in May 2010. It includes suggested sections for delivery in online and blended courses and contains suggested text and examples, where appropriate. Go to the ELITE website to see a draft version of the Online Syllabus/Examples document. You may borrow freely from this examples document. Additional examples from your own online syllabus are welcome and can be emailed to either Tom Cantu or Buddy Muse for inclusion in future versions of the Template/Examples document.

Looking slides. By clicking on Design Ideas (available from the Design tab), PowerPoint generates numerous suggestions, based on your content, to automatically create slides with different layouts, backgrounds, and style options. Design Ideas empowers a non-designer to create slideshow presentations like a professional. This new feature is only available from Office 365.

Record a Screen Capture from PowerPoint

With PowerPoint 2019, you can easily create a screen capture by first clicking the Insert tab and then clicking on Screen Capture. This will record your computer screen and related audio to embed in a slide. The video can also be saved as a separate file if preferred.

Ideas in Excel

Ideas in Excel is a new feature intended to help anyone understand spreadsheet data through high-level visual summaries, trends, and patterns. Diagrams and charts are automatically generated by clicking a cell in a data range and then clicking the Ideas button on the Home tab.

Microsoft Translator

Microsoft Translator is a new feature added to Word, Excel and PowerPoint. It supports more than 60 languages. The text translator feature is available in Office 2019 and Office 365 and does a good job generating fast and highly accurate translations. To access it in Word, open the Review tab and proceed by clicking the new Translate button. The document translation language must be first set before hitting the Translate button to finalize the text translation.

LaTeX Equations

Crafting beautiful equations just got easier for MS Word users. Construct math equations with the popular LaTeX syntax that is now available in Word 2019 and Word 365. The equation building feature can be very useful for instructors in the disciplines of mathematics, physics and computer science. To begin constructing your equations with LaTeX use the combination keys Alt + =.

Convert Office Files to PDF

You can now easily convert a Word, Excel, or PowerPoint document by choosing Save as Adobe PDF from the File menu. Did you know that you can also export PDF’s to Word, Excel and PowerPoint? Try it today!

Use the following resources to support you in becoming a more proficient Microsoft user.

Courses and Guides:
Microsoft Office
365 Training Center
Microsoft Office Downloadable Guides

LinkedIn Learning:
Essential Training
Increase Your Productivity with Office 365

Contact the IT Service Desk at 240-567-7222 or by e-mail to address any additional questions or issues.
ELITE 2019 Faculty Showcase Review: MC Faculty Share Research and Renewable Assignments in Support of Open Pedagogy

The 2019 ELITE Faculty Showcase annual event was held on Friday, December 13, in GU 222 at the Rockville campus. The showcase focused on “Practicing Open Pedagogy at Montgomery College” to explore possibilities and opportunities that Open Educational Resources (OERs) can offer for teaching and learning. Strong presentations closed the academic year with excitement and a very strong message.

Three faculty members from three different disciplines took time during a very busy week at the end of the semester to share their knowledge, challenges, and struggles with another MC faculty. Each member discussed their process for creating OERs and renewable assignments that align with one or more United Nations Sustainable Development Goals (UN SDGs.)

Mary Beth Johnson, School of Education professor, discussed the process of developing three lessons based on Goal 6: Clean Water. Professor Johnson recounted her experience learning about open pedagogy and shared the steps she took for the deployment of a survey lesson on clean water to a fall semester reading class.

Mary Wall, Math professor, discussed the process and results of deploying renewable assignments over the Fall 2019 semester in MATH 284: Linear Algebra. Professor Wall targeted Goal 4: Quality Education and Goal 8: Decent Work and Economic Growth. To meet the goals, she developed three renewable assignments: Student Success, Career Connections, and Numeracy. During the presentation, she went over how each assignment connected to each goal.

Zev Cossin, Anthropology professor, discussed his work in archaeology and open pedagogy. His work centered on Goal 2: Zero Hunger, Goal 3: Good Health and Well-Being, Goal 11: Sustainable Cities and Communities, and Goal 12: Responsible Consumption and Production. Professor Cossin shared two renewable assignments: Mapping Food Access (using Google Maps) and Finding Food for Free (in weeds) by using an “Archaeological Survey” to identify edible weeds around MC campus to use in recipes. He went one step further by asking his students a loaded question: Is food more than just subsistence?

The showcase event ended with a discussion panel and a rejuvenated audience eager with questions.

Presentation resources are available on the ELITE website.

- Mary Wall – Renewable Assignments in Mathematics Teaching.

Faculty and staff who missed the presentations can view the Faculty Showcase Video.
Employee Learning Pathways

Have you made a resolution to attend a professional development class?

Learning Pathways provide in-depth exploration of a topic and you can attend one class; if you attend all, you are awarded a certificate of learning!

Learning Pathways:
- Change Management: Moving to the Next Level
- Communication and Conflict
- Customer Service
- Effective Committees
- Equity and Inclusion
- Management
- The Valuable Employee (online)

Open Educational Resources (OERs) “Passport” Training

The goal of OERs Passport is to inform faculty about the concept of Open Educational Resources, OERs licensing, evaluating, sharing, and accessibility, and open pedagogy.

The online delivery approach allows faculty to access training resources on an any-time, any-place basis.

OER Passport Spring Schedule:
- Jan 30 - Feb 13
- Feb 20 - March 5
- March 26 - April 9
- April 23 - May 07

The image contains text and diagrams related to Employee Learning Pathways and Open Educational Resources (OERs) “Passport” Training. The text describes various workshops and courses offered, including Change Management, Communication and Conflict, Customer Service, Effective Committees, Equity and Inclusion, Management, and The Valuable Employee. It also mentions the OERs “Passport” training, which aims to inform faculty about open educational resources and related concepts.
Upcoming Professional Development Events for Spring 2020

WEBINARS

Mental Health in the Online Classroom, Tuesday, February 4, 2020, 10:00 a.m. to 11:00 a.m.

Facilitators: Emily Rosado (Professor of English, Montgomery College and Stephanie Will, Mental Health Services Program Manager, Montgomery College)

This session will discuss how to recognize students who may be struggling with their mental health, how to respond appropriately, and how to refer them for additional support. Go to Mental Health in the Online Classroom SP20 to register.

Accessibility Resources, Tuesday, February 18, 2020, 10:00 a.m. to 11:00 a.m.

Facilitator: Deb Dorsey (Assistant Professor of Health, Harford Community College)

This webinar will review free easy-to-access resources you can use in your online courses to help make them accessible. Go to Accessibility Resources SP20 to register.

Flex Courses, Wednesday, March 25, 2020, 10:00 a.m. to 11:00 a.m.

Facilitator: John Bone (Program Director / Associate Professor of Multimedia Technology, Allegany College of Maryland)

This webinar will review the challenges and successes of setting up and offering Flex courses. “Flex” refers to a single course that is concurrently offered in three formats: face-to-face, hybrid, and online. Students are able to take the course in any of the formats – which presents unique challenges when designing and teaching the course. Got to Flex Courses SP20 to register.

The Maryland Open Source Textbook (M.O.S.T.) Commons, Maryland’s Collaborative, Online Open Educational Resources Platform, Tuesday, March 31, 2020, 2:00 p.m. to 3:30 p.m.

Facilitators: MJ Bishop (Associate Vice Chancellor and Director, William E. Kirwan Center for Academic Innovation University System of Maryland), Colleen McKnight (Director of Library Services, Frederick Community College, M.O.S.T. Commons Library Fellow), and Melissa Goldberg (Consultant, edBridge Partners)

During this webinar presenters will provide an overview of the M.O.S.T. Commons, demonstrate how the site works, provide participants with a preview of the searchable resources and collections and ways faculty and staff can upload and/or create resources, show examples of ways Maryland educators are collaborating on their OER initiatives using the M.O.S.T. Commons functionality, and answer participants’ questions. Go to Using the Referatory SP20 to register.

Copyright, Fair Use, and Creative Commons, Thursday, April 16, 2020, Time: 10:00 a.m. to 11:00 a.m.

Facilitator: Buddy Muse, Program Manager, E-Learning, Innovation, and Teaching Excellence (ELITE)

In this workshop the complex concept of copyright is defined and described. Creative Commons, a licensing agent that works with copyright, yet is different from it, is also explained. Go to OER Copyright SP20 to register.

MOLLI – Leading from Where You Are: Perspectives in Faculty Leadership, April 30, 2020, 10:00 a.m. to 11:00 a.m.

Go to MOLLI Faculty Leadership SP20 to register.
EXTERNAL EVENTS

**MOLLI - Diversity in Leadership Event**, Friday, April 3, 2020, 10:00 a.m. to 3:00 p.m., Harford Community College

**Accessibility Fix It Workshop - Co-sponsored with Maryland Distance Learning Association (MDLA)**, Monday, May 18, 2020, 9:00 a.m. to 4:00 p.m., Chesapeake College

Facilitator: Deb Dorsey (Assistant Professor of Health, Harford Community College)
More information and registration link to come.

**Accessibility Fix It Workshop - Co-sponsored with Maryland Distance Learning Association (MDLA)**, Monday, June 1, 2020, 9:00 a.m. to 4:00 p.m., Garret College

Facilitator: Deb Dorsey (Assistant Professor of Health, Harford Community College)
More information and registration link to come.

**Save the Date!**

The Fifth Annual Love of Teaching Conference - Expanding the Circle: Deepening Our Love of Teaching through Culturally Responsive Teaching

Saturday, April 25, 9:00 am - 12:00 pm, Rockville Campus

Be on the lookout for e-mail on how to register for this event!

Office of E-Learning, Innovation, and Teaching Excellence (ELITE)

ELITE provides faculty and staff with the support they need to further the mission of student success. Our workshops prepare our faculty to teach their classes both on-campus and online with the pedagogical and technological tools and knowledge. We offer a variety of workshops during the fiscal year for our staff to enhance their personal and professional development. In addition, ELITE offers several different learning pathway certificates for all employees from leadership and career development to communication and interpersonal skills.

ELITE team is committed to providing excellence and leadership to the diverse MC community in the areas of instructional professional development, learning technology support and college-wide academic initiatives. We hold ourselves accountable to seek and provide practical, innovative solutions to enhance the learning experience of faculty, staff and students.

https://www.montgomerycollege.edu/offices/elite  |  240-567-6000  |  dl@montgomerycollege.edu